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Copyright

Copyright © 2011 NHN Corp. All Rights Reserved.

This document is provided for information purpose only. NHN Corp. has endeavored to verify the
completeness and accuracy of information contained in this document, but it does not take the

responsibility for possible errors or omissions in this document. Theref ore, the responsibility for the
usage of this document or the results of the usage falls entirely upon the user, and NHN Corp. does

not make any explicit or implicit guarantee regarding this.

Software products or merchandises mentioned in this document, in cluding relevant URL information,
conform to the copyright laws of their respective owners. The user is solely responsible for any results
occurred by not complying with applicable laws.

Important Information Regarding Open Source Licenses

There are seve ral types of open source licenses. XE is licensed under the GNU Lesser General Public
License (LGPL) v2. As there is a slight difference between LGPL v2 and LGPL v3, it is important to

keep the version in mind. LGPL is basically the same as GPL, but its sc ope of application is more
restrictive. Like GPL, LGPL has the effect of forcing all software that includes any LGPL-licensed
software to have the same license. While GPL requires all software that includes any GPL -licensed
software to unconditionally open its source codes, LGPL-licensed programs do not need to open their
source code when they are used under specific conditions. Therefore, LGPL-licensed software can also
be used for developing proprietary software. For more information, see the website below.

LGPL License: http://www.gnu.org/copyleft/lesser.html

GPL License: http://www.gnu.org/licenses/gpl.html
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Introduction to Document

Document Overview

This document describes how to install and use XE which enables you to build website s and

manage contents.

Audience
Audience of this document is users who want to build and operate website s including Cafes and

blogs by using XE.

Contact

For any co mments or inquiries regarding the document, contact via email below.

Email: developers@xpressengine.com

Revision History

Ver. Date Changes Mode

1.0 2010.10.29 1.0 version distributed.

2.0 2011.12.30 Updated based on XE core 1.5
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Conventions

Note Symbol

Note

A note provides information that is useful for readers.

Caution Symbol

Caution

A caution provides information that you should know in order to prevent system damages.

Window, Site, Menu, and Field Names/Selected Value and Symbol

Window, site, menu and field names, a selected value, and a symbol are marked as follows:

A Wwindow name: Inbold type suchas window name window. Note that  this convention is not
applied in source code.

A Site name: Enclos ed in single quotations such as ‘Naver Desktop Download Ssite.

A Menuname: Inboldtype suchas Menu > Submenu

A Input value: In italic type such as homepage .

Source Code

Source code is written in black on a gray background in this document.

COPYDATASTRUCTt;

st.dwData = PURPLE_OUTBOUND_ENDING;

st.cbData = sizeof(pp);

st.IpData = &pp;

::SendMes(GetTargetHwnd(), WM_COPYDATA, (WPARAM)this - >m_hWnd, (LPARAM)&st);
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1. Introduction to XE

This chapter provides a definition of XE, and describes its features and characteristics.



1. Introduction to XE

1.1  Whatis XE?

The name 'XE' is a combination of two words, ‘eXpress ' and 'Engine. ' It can be defined as a
system to help people express their thoughts or feelings. '
XE is a website creation program that is install ed on a server computer. To make a website ,

you generally need to know programming languages such as HTML, CSS, PHP and SQL. But if
you use XE, you can easily make a website without being familiar with any programming
languages.

Based on a core program, XE core, XE enables you to combine various features and make the
website you want.

Skil'l Design

Layout Widget (widget style)

Module Add on Function
XE Core
PHP

wEh Server Platform

Figure 1-1 XE Summary

Note

For detailed information on XE, see the official XE website .
http://www.xpressengine.com
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1.2

1. Introduction to XE

Features and Characteristics of XE

The features and characteristics of XE are as follows:

Easy Website Construction

XE provides diverse modules such as Textyle (blog type), CafeXE ( Cafe type) and PlanetXE
(micro -blog type). You can conveniently construct the website you want to make by selecting
the appropriate modules.

Modular Structure

A module in XE is a program. XE is composed in a modular structure, making it easy to
construct, add and use features, like building with Lego blocks. You can construct diverse
website s by combining the basic modules provided by XE with the extended features shared
through communities. Developers can easily develop additional modules for XE with new
feat ures, and share them through XE communities.

Open Community

XE provides a lot of information through its open community. In the XE community, there are
many users who have used XE since ZeroBoard, and free and open source project members.
Users can search  the community for the information they want, and ask other users for the
information at will.

Multi-language Support

XE supports multiple languages for multiple countries. You can easily create a website that
displays in English, Japanese, Chinese, Russia n and others languages, as well as Korean,
without the separation of the website by language.

11



1. Introduction to XE

13

12

Terminology

Filezilla

A free file transfer protocol (FTP) program. Its official website is http://ffilezilla __-project.o rg/ .

mod_rewrite

A function that shortens a long URL to make it easy to remember. For example,

http://  example .com/index.php?module=admin can be shortened to

http:// example.com /admin. This feature can be used only when it is supported by the Web
server.

PUuTTY

A remote access program that supports Telnet or Secure Shell (SSH) protocol. The official
website is http://www.putty.nl

WPI

An a bbreviation of Web Platform Installer. Microsoft provides this tool to enable the use of
Web Platform products, and its official website is http://www.microsoft.com/web/default.aspx
XE core

Core program that is responsible for the installation and operation of XE. XE core is used to
install and execute  extension s, such as module, layout and skin.

Extension s of XE

Components that can be added to XE core for user convenience in website operation. They
include modules, addon s, widgets, skins, widget styles and layouts.

XE
An abbreviation of Xpressengine. Thisisthe  website builder program that is installed on and
used from a server computer, and its official website is http://www.xpressengine.com/

Virtual website

This function enables you to use a web page made by XE as another website separate from
XEO®s d evebsitel t

Layout
A component that is responsible for the arrangement of extension sinstalled ona website .


http://filezilla-project.org/
http://www.putty.nl/
http://www.microsoft.com/web/default.aspx
http://www.xpressengine.com/

1. Introduction to XE

Module

Program that can be  added to XE for use

Easy Install
This feature enables you to install a selected extension by interworking with the official
website for XE without downloading any source program from the official website for XE and

uploading it to a server.

Skin

A design of program installed on any websit e.

Addon

A small program that make s an interrupt between the operations of module features to
perform their own functions

Widget Style
A component that decorates the appearances of widgets

Widgets

A component inserted into a layout or a page module for o peration .

ZeroBoard

The most popular b ulletin board system that was developed in 1999 in Korea . The software

has been developed into the current XE through ZeroBoard XE.

13






2. Installation and Removal

This chapter describes how to install and uninstall XE.



2. Installation and Removal

2.1 Prerequisite

XE is a web application for setup. To create a website by using XE, you need a web server on
which XE is installed. The server space to install XE can be secured in several ways, but the

follo wing two ways can be considered: using a computer directly as a server, or leasing web

server space provided by a web hosting provider at some cost.

2.1.1 Required Programs

The list of program srequired for installing XE inthe web server environment is shown in the
table below. If you use Microsoft Web Platform Installer to install XE , the programs listed in
the table will be automatically installed. If you do not us e one of these installers, you must
check and set up the require d programs and libraries in advance.

Table 2-1 The Listof Required Programs

Program Mandatory/Optional
PHP 4.x ~ 5.x (excluding Mandatory
5.2.2)
PHP library XML library Mandatory
GD library Mandatory
ICONV Optional
Database Management System CUBRID Choice
(DBMS) Firebird

MySQL 4.1 or higher

PostgreSQL
SQLite2 and SQLite3
MS-SQL

2.1.2 Downloading XE Core Setup File

To create a website by using XE, you must set up XE core. XE core is the core program
responsible for the installation and operation of XE. XE does not have any website
management related features. However, XE core is essential for the installation and execution
of extension s such as modules, layouts and skins.

You can download the latest XE core setup file from the website
(http://code.google.com/p/xe -core/downloads/list ) for free.
Note

If you install XE by using WPI on Windows, you do not need to download the XE core setup file.

The XE core setup file is provided in two types, which are zip and tgz. Download the zip file if

you want to upload the files to the server after extracting them on My Computer, or the tgz

file if you want to extract the compressed file after uploading it to the server. For more

information in the file upload method used for each type, see "Uploading XE C ore Setup File by
Formats ."

16
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2. Installation and Removal

2.2

Setting Up a Server Environment

Regardless of the type of server OS, XE can be installed in all environments where "Required
Programs " is installed. You must build the required Web server environment before installing
XE.

You can install XE and the required program s in the Windows environment by using WPI. For
more informa tion, see the example  "Setting Up a Windows Environment ."

Before installing XE in the Linux environment, you must install the programs in "Required
Programs " manually. The detailed setup procedure for each program is not covered in this
document. For detailed information on setting accounts, getting access to a server from a

remote website and uploading the XE core setup file, see "Setting Up a Linux Environment

17



2. Installation and Removal

2.3

18

Installing XE Core

This section describes how to install XE core by using the XE core setup file.

1. With a Web browser, access the path (www.
the XE core setup file is uploaded.

2. When the XE Installation window appears,

environment information if you agree with that, and

example.com or www. example.com /xe), where

check GNU Lesser General Public
License(LGPL v2) Agreement ,and Agreement on gathering installation

click | agree

with the license

\' -« ‘ > |+ | http://manual. dev. xpressendine. com/xe;

| O- #-

&2 Xpress Engine

@ Acceptance of terms

To use XE,

English

Version

XE Installation

[l GNU Lesser General Public License(LGPL v2) Agreement

[l Agreement on gathering installation environment information

i

on server. This information is collected anonymously and

1agree with the license

Note

If this page has a broken image or is empty, you must upload the XE core setup file again.

3. Check to ensure all required setup conditions are marked as

installation

This window shows whether the minimum PHP version and the
installed. If any of the required setup conditions are not marked as Enable, check the error

message and mark the item.

Enable , and click Continue

required libraries are

Note

If Permission is marked as Disable due to a file permission settings error, see

Permission Settings When Installing XE

"Incomplete

4. Select the DBMS to be used in XE, and then click
document, select mysq|

Continue install

ation

. In case of this




2. Installation and Removal

Note

If there is no DBMS avai lable in XE, all items will be deactivated. In this case, install the DBMS to be
used, or ask your  web hosting provider to install it.

5. As shown in the figure below, enter the required information for DB, and click Next .

| 4@ | | + \ hitp://manual. dev. spressengine, com/=e | O~ &~

Version XE Installation

mysql
DB Hostname

locahost
°

DB Port

@ Input Database information 3306

o DB ID

xemanual

DB Password
Prerree
DB Database

xemanual

Table Header

Xe

Please check to server master.

modify database . and can small letters(small letter is
nded), and numbers, but you can not u: ecial lette

1 Go Back

Note
If a problem occurs ~ while you enter DB information, see "Incorrect DB Account Information

6. Check whetherto use  Rewrite mode ,and setthe website's local standard time , click
Next .

7. Enter the information for administrator. Since XE 1.5 or higher version uses an email
address as login account, you need to enter the actual administrator's email address.

19



2. Installation and Removal

\_ < |+ || 4+ | htpt//manual dev.spressengine. comie/ I O- s~

Xpress Engine Version XE Installation

Email
admin@mydomain.com

New Password

Retype New Password

User ID

@ Enter Administrator admin

HNick Name

information
admin

orm must g 0 nodify all of s ter finish the instaliati

1 Go Back Done

8. When the installation is completed, the XEO6s | ndex AdildppearRsasposn in the
figure below:
\: ] | > | [+ | nite://manual.dev. xpressengine, com/xe/admin ] O~ &~

admin@rmydomain.com | Log-out = English

}e XE Admin

Dashboard Site Member Content Theme Extensions Settings i Favorite
Current state Latest Document

Member 1(+1) Welcome XE admin
Document 1(+1)

Comment o(0)

Trackback o(0)

File 0(o)

Latest Comment Latest Trackback

There is no data. There is no data.

Notice Favorite

XprassEngine Core ver. 1.5.1 There is no data.

XpressEngine Core ver. 1.5.0.9
XpressEngine Core ver. 1.5.0.8
XpressEngine Core ver. 1.5.0.7

XpressEngine Core ver. 1.4.5.10

Powered by XE (ver. 1.5.1). Reset admin menu Re-create cache file Clean up session Bug Report

20



2. Installation and Removal

2.4

Removing XE Core

If XE is no longer being used, delete all contents under the folder where XE is installed.

All data used for the administration of the website created by XE is stored in the database. If
you want to delete all data, delete a Il DB tables used for the administration of your website .
When you install XE again or transfer your server, you can reuse the data after migration.

For detailed information on how to delete or migrate data, see the usage of DBMS used for the
administrati on of your website .

21






3. Menus of XE Core

This chapter explores each menu of XE core



3. Menus of XE Core

3.1 Index Admin Page

As shown in the figure below, open the XE Admin Page , enter the administrator account and
log into the page.  'example.com ' of the address below indicates the domain address where XE
is installed.
A When using mod_rewrite: http:/ example.com /admin
A When not using mod_rewrite: http:/ example.com /index.php?module=admin
[« [» | [+ ] ntte://manual.dev. xpressenging. com/se/admin | - $$~

admin@mydorrain.com = Log-out | English

Dashboard Site Member Content Theme Extensions Settings Favarite
Current state Latest Document

Member 1{+1) Welcome XE admin
Document 1(+1)

Comment 0{0)

Trackback 0(0)

File 0(0)

Latest Comment Latest Trackback

There is no data. There is no data.

Notice Favorite

X¥pressEngine Core ver. 1.5.1 There is no data.

XpressEngine Core ver. 1.5.0.9
X¥pressEngine Core ver. 1.5.0.8
XpressEngine Core ver. 1.5.0.7

XpressEngine Core ver. 1.4.5.10

Powered by XE (ver. 1.5.1). Reset admin menu Re-create cache file Clean up session Bug Report

Figure 3-1 XE Ad min Page
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3. Menus of XE Core

3.2

3.21

3.2.2

3.2.3

3.2.4

XE Administration Menu

This section describes the default menu available for the administrator.

Dashboard

This menu shows the XE Admin home, including current status of the website, latest
trackbacks, notice and favorites.

Site

Site Map

This menu is used to build complete websites with no manual work by arranging created

modules and connecting  them to layouts through the convenient menu management. The

menu only has the information to connect modules to layouts and show various types of

menus through the layouts, and not to manage websites. When you add a menu, you can also
create a module to connec  twith , and directly open the admin page of the module

Member

Member List

This menu shows the list of members who registered in this website. This menu is used to
create, edit and delete member information; for example, you can change member groups or

block login of a member

Member Setting

This menu is used to set the information required for member management , including Accept
New Members and Signup Form.

Member Group

This menu is used to manage member groups; you can create, change or delete groups.

Point

You can grant points to members when they write, upload or download original posts or
comments. In addition, you can set the level of groups, and set to upgrade the level based on
points.

Contents

Document

This menu is used to manage documents register ed on website s. You can see and delete
document contents and check reported/deleted documents.

Comment

This menu is used to manage comments registered on websites. You can see and delete
comment s, and check reported comment s.

25



3. Menus of XE Core

3.25

3.2.6

26

Trackback

This menu is used to view the lists of trackbacks or links from outside the site. You can select
whether to allow trackbacks or not. If trackbacks are not allowed, they cannot be received and
will not be displayed even if you link them.

File

This menu is used to manage files attached to posts. You can delete the attached files as well.

Poll

This menu is used to manage polls registered on websites.

RSS

This can provide integrated Rich Site Summary (RSS) feeds composed of various modules
created through XE. The default value is touse Aggregated Feeds . Integrated feeds are
provided through the initial website window, and individual modules not allowed to open feeds
are excluded from the RSS feed list. As in some modules, the default value of open feed is set
to Do Not Open , you must check whether the Open Text itemissetto Open Full Text
Feed or Open Feed Summary in the Additional Settings of each module.

Multilingual

XE supports multilingu  al website; you do not have to create separate global websites. You can
add words and sentences to Multilingual, and they are automatically applied to the website Uls
and displayed when you change the language.

This menu manages the list of multilingual wo rds and sentences; you can check the list and
add new words or sentences.

Data Migration

This menu is used to import data from ZeroBoard 4, zb55beta or other program.

Trash

When you delete documents or comments, they are moved to Trash, not actually delete d from
DB. The administrator can restore them or completely delete them.

Theme

Theme

Theme is a set of skins and layouts for modules currently installed. This menu shows all

themes and modules installed in the website. When you select a theme, the module s kin is
changed to the selected theme ( No Selected XXX Skin means that the selected theme does
not support the module). When you save the theme setting, it is applied to the skin and layout
information in all the module instances created in the website.

Extensions

Easy Install

This menu enables you to setup the extensions including modules, skins, layouts, and widgets
on your website by  connecting with the official website for XE . You do not need to download
the source from the official website and uploa d it to your server.



3. Menus of XE Core

3.2.7

Installed Layout

This menu is used to manage the layouts installed on the website. You can add, edit or delete
instances .

Installed Module

This menu shows the installed modules . You can manage modules on the management page
for each m odule. You can also set frequently used modules as Favorite so that you can
conveniently use those modules by using Favorite menu on upper right side of the page.

Installed Widget

This menu shows the installed widgets . You can create code for each widget.

Installed Addon

This menu shows the installed addons. You can set whether to use each addon on PC and
mobile device.

Note

Using XE core 1.5 or higher version, y ou can delete layouts, modules, widgets and addons installed
by using Easy Install  on the manage ment page of Extensions > Installed Layout, Installed
Module, Installed Widget and Installed Addon

WYSIWYG Editor

This menu enables you to set the basic WYSIWYG editor and manage the editor component.

Spam Filter

This menu is used to identify spam posts or comments and block them . You can set IP
addresses and keywords to ban.

Settings

General

This menu is used to set  basic matters such as the default module for the site and the default
language. Italso enablesyou to set advanced matters such as IP address band that can

access the Admin Page.

FTP Configuration

This menu is used to set user ID and password for FTP connection in order to use Easy Install.

Admin Setup

This menu is used to set title, logo and menus for the Admin Page.

File Upload

This menu is used to set the allowed formats and size of files to upload.

FileBox

This menu is used to manage FileBox, which contains images that can be reused by
administrators. W hen you upload an icon for a member group, the image file is uploaded to
the FileBox.
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4. XE Extensions

This chapter describes  types of extension sin XE, and how to install them.



4. XE Extensions

4.1

Types of XE Extensions

The biggest advantage of XE is that XE enables you to operate website s more conveniently by
adding diverse features. This section describes the extension s of XE. For information on how

to install each extension , see "How to Install Extension s."

Module

A module in XE is a program. Multiple modules can be combined into a bigger module, and
each module can operate independently. In short, modules are programs that are additionally
installed to implement specific features on website s.

Bullet in board, CafeXE and Textyle can be considered the representative modules provided in
XE.

)(E XpressEngine e

Home. AboutXE XE core Download Project Hosting Community [ a]

Figure 4-1 Modules

Addon

A small program that interrupts between the operations of modules and performs its own
operations. In addition to modules, addon s execute their own features by themselves.
However, addon s are different from modules in that they do not provide the execution

to outside.

results

Default counter and mobile XE are examples of the representative Addon s provided by XE.
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4. XE Extensions

Widget

A widget is inserted into and operated in a layout or a page module. Widgets can display data
already created in modules, or create its ow n data. For example, you can use a widget to
display the list of the latest posts in the front page of your website . Language selection and
login information display widgets are examples of representative widgets provided by XE.

Widget Style

A widget styl e is used to decorate a widget. If a skin decorates the output part of a widget,

the widget style can be considered a skin for the appearance of a widget. By applying widget

styles, you can add contents, such as titles and other links, to widget blocks as well as change
their appearance.

)(E Xpress Engine

Home AboutXE XE core Download Project Hosting Community

Widget Style

Widget

Widget Style

Widget

Figure 4-2 Widget and Widget Style

Skin
A skin is the design of programs installed in website s. In other words, a skin can be
considered as the clothing of a program (modules or widgets).

The XE official website provides various skins for each program. Appropriate use of these skins
will make you operate a better website that reflects your unique personality.

31



4. XE Extensions

Layout

After installing various extension s onyour website ,you mustar rangethem on the screen
appropriately. The layout is responsible for this screen arrangement. A layout has a very close
relationship with  extension s such as modules and widgets. As the layout cannot display any
content without  those extension s, nothingis displayed in the screen. If, in the other hand, a
program is installed but there is no layout, the screen will also remain blank or empty because

each element will not know where it is to be displayed.

NAVER

API = ASXHSOA
M2 40| 7 XE Core 1.4.4.1

e

TEXTYLE 1.3.1
Manual / Guide
Modules

Skin

1.4.4.2 Betal Wi EFLIC}
o2 eset © r7744 - 7765

ol X A

OHfle E2iMel &
"

RN

B 0] 01L&
- ol
=
L]

el IISE SH0E B2E AYR A=S

Figure 4-3 Layout
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4. XE Extensions

4.2 How to Install Extensions

Various extension s can be installed in XE in two ways: Uploading source files to the server
where XE is installed after downloading the files from the official XE website , and using Easy
Install provided by XE core.

Not e
Installing extension sin XE means transferring the source codes of the extension s into the operating
server. In short, the contents to be displayed in the actual website cannot be created through the

installation of the  extension s alone. For more informa  tion on how to create extension s and make
them interwork  with website s, see "Creating Website s."

4.2.1 Installing Extensions by Uploading Source Files

You can download source files for extension s from the XE official  website , and upload them to
the server where XE is installed.

Note

Please understand that this document was originally prepared for t he users who use XE's Korean
official website . We will soon release a new document for worldwide users  of global website.

For example, to install a bulletin board module by uploading source files, do the following.

1. Access the archive of the XE official website (http://www.xpressengine.com/download ).

2. Select one of the bulletin board modules and download it to My Computer.
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3. Extract the bulletin board module from the zip file you have downloaded. When the
extraction is complete, a directory called ‘board ' is created.

4. Move the extracted 'board ' directory to the  './modules ' directory underthe  XE installation
path . All modules are installed inthe  '/modules ' directory under the  XE installation path

5. Select Extensions > Installed Module and c heck if the board module is added as shown
in the figure below.

| 4 » ||+ ntipi//manual dev. spressengine. cam/xe/admin | O~ 2~

admin@ omain.com | Log-out | English

&2 XE Admin

Dashboard Site Member Content Theme Extensions Settings Favorite

Extensions | Installed Module

Easy Install Installed Module | Module Category

Installed Layout All(32)

Installed Module Favorite Module Name Version Developer Path Delete

Installed Widget I/\\s

=
=
=

Addon 0.1 ./modules/addon/

Installed Addon This module is for

WYSTWYG Editor maintaining addons
which can toggle

Spam Filter between two states
when use and not
used.

=
[+
=

Administrator 0.1 Jmodules/admin/

Module

This module shows a list
of features for each
module. By applying the
administrator layout it is
possible to use
administrator features.

0.1

=
=
=

Jmodules/adminlogging/

=
b
=

EasvInstaller 0.3 ./modules/autoinstallf

With this module, you
can install and uparade
your pragrams including
modules, skins, kyouts,
etc., from
WWW.Xpressengine.com
with one-click.

=
=
=

Board 1.4.1 Jmodules/board/

Module in charge of
function of the board.
Also indudes
administrator functions
such as
creating/managing
boards.

You can update
this itern. Would
you like to update?

6. Click Would you like to update? to complete the installation.
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Installing Extensions by Using Easy Install

Setting FTP

Toinstall extension s by using Easy Install , you must setthe acc ounttouse Easy Install . The
procedure used to set an account is as follows:

1. Click Settings > FTP Configuration on the XE Admin Page .
2. Enterthe information for FTP connection as shown below:

FTP hostname : The host address which the server where XE is installed will access.
Unless otherwise specified, XE components are usually installed in the server where XE
is installed. Therefore, enter localh ost or 127.0.0.1

User ID : A user ID for the server
Password : A password for the user ID

FTP port : By default, the FTP port number is set to 21, but it may vary depending on
the server. If the port number is not 21, contact your server administrator.

Use FTP Passive Mode ?: This feature enables you to use FTP service normally even
when clients (web server to be used) are behind a firewall. To get FTP connections to
work through a  firewall, select Yes. Therefore, touse Easy Install , the server must
support the FTP Passive mode.

Use SFTP ?: The data transferred via FTP is not encrypted . Using SSH File Transfer
Protocol (SFTP) enables you to use Easy Install more safely. Youcanuse SFTP only
when the related PHP module is installed.

Absolute FTP path of XE:FTP path indicates the absolute path to the location where
the XE source code exists. Enter the absolute FTP path. For example, if the account for
XE installation and FTP setting are ‘xemanual ' and the path to XE source is

‘lhome/x emanual/xe ', you must enter the absolute FTP path of the xemanual user,
which is /xel .

Note
To entera home directory, you must add 'I" to the end of the directory path.
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< | = || + | hitp://manual.dev.xpressengine. com/xe/ fmodule=admin&act=dispAdminConfigFtp | - 5

admin@rmydomain.com | Log-out | English

Dashboard Site Member Content Theme Extensions Settings . Favorite
Settings | FTP Configuration
General FTP hostname [2]
FTP Configuration 127.0.0.1 Default : 127.0.0.1
Admin Setup User 1D
File Upload xemanual
FileBox
Password
........ FTP password will not be stored.
FTP port
21 Default : 21

Use FTP Passive Mode?

@ Yes ) Mo

Use SFTP?
7 Yes @ No

Absolute FTP Path of XE

Get List
Absolute Path of XE : /home/xemanual/xe/
Save
Powered by XE (ver. 1.5.1). Reset admin menu Re-create cache file Clean up session Bug Report

3. Click GetList ,andi fyou can get listwith no error, click Save .

Now, the account setting to use Easy Install is completed.
Note
If any error related to FTP home directory occurs during the execution of Easy Install , see "FTP Home

Directory Inacce ssible during Easy Install ."

Using Easy Install

For example, the procedure used to install the Textyle module through Easy Install is as
follows:

1. Click Extensions > Easy Install on the XE Admin Page

2. Find the Textyle module and click Insta |l at the right side of the module description. When
the module is installed completely, Install button disappears.
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CE

hite A/ manual. dev. xpressendine, com/ e/ 7oategory_srl=&module=admin&act=dispautoinstall sdminindexdsearch_keyword=taxtyle |

O~ £~

&2 XE Admin

Dashboard

Extensions

Site Member Content Theme Extensions

Easy Install

Installed Layout
Installed Module
Installed Widget
Installed Addon
WYSIWYG Editor

Spam Filter

| EasyInstall

Settings

admin@mydomain.com | Log-out | English

|, Favorite

If the FTP configuration is not set, the instalation or update
before using EasyInstal.

will not work. Pleas configure the FTP information. Click update button
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5. Creating Websites

This chapter describes how to create website s by installing various  extension s. While XE enables you
to create various  types of website s, this chapter only describes how to create basic website s and Cafe

and blog type website s.



5. Creating Websites

5.1 Creating a Basic Website

This section covers how to create a simple and basic website to display three  board s, menus
linked with each  board and the latest posts  on the main page.

The complete website that will be created in this section is shown in the figure below.

‘:if\ | + | http://manual.dev. xpressengine. com/xe/?module=admin&act=dispBoardAdminBoardinfo&module_srl=51 e o A2

PROFILE  KOREAN  SELECT LANGUAGE

Notice Freeboard Levelup _

Freeboard more

[TAMIYA] 1/32 scale F-15C @& Aug 29, 2010 23:41
admin
test Content1

[Revell] mig-29 1/32 @« & Aug 29, 2010 23:38
admin

test Content 2

Notice more  LevelUp Board mare

Notice Title 1@ 7 admin Level Up Title 1@ Aug 27, 2010 admin

Notice Title 2@ admin Level Up Title 2@ Aug 27, 2010 admin

Notice Title 3@ admin Level Up Title 3@ Aug 27, 2010 admin

Notice Title 4 @ admin Level Up Title 4 @ Aug 27, 2010 admin
Level Up Title 5@ Aug 27, 2010 admin

™" Home Notice Freeboard LevelUp

Ak

Figure 5-1 Basic Website

5.1.1 Installing Extensions

Installing a Layout

Install a layout module before creating a website .

1. Moveto Easy Install window by clicking Easy Install atthe top left ofthe XE Admin Page .

2. From the layout skins, search for 'XE official Ver2, 'and click Install at the right side.
Note
You can also install  extension s by uploading source files with no use of Easy Install . For more
information, see the example "Installing Extension s by Uploading Source Files ."

Installing a Board Module

Install the board module. For more information on installing modules, see "How to Install
Extension s."
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51.2

Managing Site Map

You can create and manage modules of your website using Site Map menu. Let's create Home,
Notice, Freeboard and LevelUp board menus , and connect them with each board or page

1. Click Site > Site Map fromthe men uinthe XE Admin Page .
2. Youcanuse welcome_menu , Which is automatically created when you install XE. First of

all, delete menul -1 and menul

+ | hitp'//manual dev. xpressengine. com/ e/ Ymodule=admin&act=dispMenu AdminSiteMapamenu_sr=59

admin@mydomain.com = Log-out | English

- -
A2 XE Admin
Dashboard Site Member Content Theme Extensions Settings Favorite
Site | site Map
Site Map
welcome_menu Collapse/Expand
menul Edit | Delete | Add
menul-1 Configure | Edit | Delete | Add
Re-create cache file Add Menu... =T

Add New Site Map...

Powered by XE (ver. 1.5.1). Reset admin menu Re-create cache file Clean up session Bug Report

3. Click Add Menu
4. When Add Menu window appears, enter Home for Menu Name |, select Create Module  for

Module or URL  and Page > Widget Page for Select Module . Enter home for Create
Module ID  and click Save . Then, you can see that the Home menu is added under the
welcome_menu

Menu Name : A name for menu. The name may contain all letters and numerals
without limitation.

Module or URL : Contents to be connected with the new menu.
Create Module : Create a new module.
Select Module : Select one from the existing modules in my website.
Menu URL : Connect to the external link (including 'http://")

Create Module ID : Aname used to access the relevant module. The name may
contain letters and numerals, but it must start with a letter. In addition, the name must
not duplicate the name of another board or page. Since the module name is the name
of the page to be displayed in the address bar of a web browser, you must use
alphabets and numbers only.

You can see that the window is converted into the Boards List taband Freeboard has
been added to the list.

Create the remaining  three menus, notice board, freeboard and levelup board inthe s ame
order as the above procedure.

notice board : Set Menu Name to notice board , select Create Module and Board for
Module or URL , and set Create Module ID to notice0O1 , respectively.

freeboard: Set Menu Name to freeboard , select Create Module and Board for
Module or URL , and set Create Module ID to freeboard 01, respectively.

level up board: Set Menu Name to levelup board , select Create Module and Board for
Module or URL , and set Create Module ID to levelup 01, respectively.
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5.1.3
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You can see that the

figure below.

four menus have been created in the

Site Map page as shown in the

22 XE Admin

+ | http://manual.dev.xpressendine, com/xe/tmodule=admin&act=dispMenuAdminSiteMap&menu_srl=53

Powered by XE (ver. 1.5.1).

admin@mydomain.com | Log-out | English

Dashboard Site Member Content Theme Extensions Settings Favorite
Site | site Map
Site Map

welcome_menu

“  home

# notice board

+  freeboard

#  levelup board

Re-create cache file

Colapse/Expand =
Configure | Edit | Delete | Add
Configure | Edit | Delete | Add
Configure | Edit | Delete | Add
Configure | Edit | Delete | Add

Add Menu...
Add New Site Map...

Reset admin menu Re-create cache file Clean up session Bug Report

Save

Creating a Layout

After creating modules and menus,
Installing a Layout ", and integrate them with menus.

layouts in "

you need a

layout to display them in the screen. Create

When creating XE layouts, you provide diverse screen effects by changing various settings.
The procedure used to create layouts is as follows:

1. Select Extensi
Click XpressEngine ver.2

2
3. Click Insert
4

Set the following items in the

click Insert
Subject

Menu:

at the bottom right of the

ons > Installed Layout
layout previously installed.

list .

: main_layout

welcome_menu

page of inserting layout, check
at the b ottom right of the window.

inthe XE Admin Page .

Apply Layouts En Bloc

and
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5. Check whether the
below.

'main_ layout'

has been added to the layout list as shown in the figure
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